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How to Create Accessible Outlook Emails and Teams Chat 
Messages 

Introduction 

Accessibility means that something can be accessed by anyone regardless of disability. Accessible emails and chat messages 

and the information therein can be accessed by anyone regardless of how they read. People with print disabilities read in 

many different, non-traditional ways. For example, a person may use a screen reader to read aloud the information in an email 

or message, or they may use a refreshable braille display that displays the information using moveable pins that form the 

shapes of braille characters. People with low vision or cognitive disabilities may want to enlarge text with screen magnification 

and/or use text-to-speech software. 

Outlook emails and Teams messages are often very visual media, but as content creators, we have the opportunity to create 

content that can be accessible to those who read differently. The main changes that we can make involve adding alternative 

text to images and considering colour contrast, font size, and clarity of text. Incorporating features that support accessibility is 

easy and it will make a significant impact for people who access that information differently. For some, it will mean the 

difference between access to information and information that is unreadable. 

The following document outlines the main features in Microsoft Outlook and Microsoft Teams that will make emails and 

messages more accessible to people who use assistive technology or who have different reading needs.  These simple 

changes can make your communications inclusive and accessible. 

HTML Format 

(applies to Outlook) 

Microsoft Outlook offers three formatting style options for creating emails: HTML, Plain Text, and Rich Text. In order for you to 

employ accessibility considerations such as headings, alternative text for images, descriptive hyperlinks, and formatted lists, 

ensure HTML is the default email setting in Outlook. 

How to ensure HTML is the default email setting in Outlook: 

1. Navigate to the “File” tab on the menu bar and select “Options.” 

2. Select the “Mail” tab. 

3. In the “Compose messages in this format” combo box, select “HTML.” 

4. Select the “OK” button. 

Images 

(Applies to Outlook and Teams) 

Images such as pictures, screenshots, stickers, icons, charts, tables, and infographics convey important information. It is 

important that all images in an email or message include alternative text (also known as alt text), which is a written description 

of the image. If a reader is unable to see the image, all the information relayed in that image is unavailable unless there is 

adequate alt text. The alt text should be concise but include enough information to relay the main features of the image. 

For images containing text, such as event flyers, ensure to transcribe all the text in the image into the alt text box. Simply 

stating “event flyer” does not provide enough information for a screen reader user to know where and when the event is 

occurring. 
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Images that convey a lot of information, such as infographics or charts, will need a “long description” or a caption, as well as 

alt text. A long description (anything more then 6 sentences) can appear wherever makes sense in the email or message, 

such as below the image or at the end of the email or message. Ensure that you include a brief alt text description for the 

image itself and indicate in that alt text where the long description can be found. 

Strictly decorative images should be labeled “decorative,” but this only applies if the image does not convey any information. 

An artistic dividing line or symbol at the end of a paragraph is an example of a decorative image. 

Logos can be described as “logo of…” and the description can include a very brief description of the logo itself. 

Finally, in Outlook, images need to be placed in line with text to be readable by screen readers. Do not wrap text around an 

image or place the image behind or in front of text. Screen readers will not be able to access those images.  

How to apply alternative text in Outlook: 

1. Select the image. 

2. Right click or open the context menu with the applications key or shift+F10. 

3. Choose “Edit Alt Text”. 

4. Add a concise description conveying the purpose of the image/object in the context of the email. 

5. If an image is purely decorative (conveys no information at all but is, for instance, a dividing line), type “decorative” in the 

alt text box. 

6. Close the dialog box (there is no “ok” or “save” button). 

Tip: Write out your description in a Word document and copy and paste it into the description box. Spellchecking features do 

not catch errors in the alt text box. 

How to apply alternative text to images in email signatures: 

1. Navigate to the “File” tab on the menu bar and select “Options” from the ribbon. 

2. Select the “Mail” tab. 

3. Navigate to the “Signatures” button. 

4. Select the signature you wish to edit from the list. 

5. Select the image in the signature and right click or press Shift + F10. 

6. Choose “Picture”. 

7. Navigate to the “Alt Text” tab. 

8. Write a concise description of the image. Logos can be described as “Logo of…”. 

9. Choose “OK” to save your description. 

How to apply alternative text in Teams: 

1. Add an image to your message. 

2. Select the image and right click or press Shift + F10. 

3. Navigate to “Edit Alt Text”. 

4. Add a concise description conveying the purpose of the image/object in the context of the message. 

5. Select “Save”. 

Note: Teams only allows for 240 characters in the alt text box. This limit offers only around three or four sentences’ worth of 

description. 

Tip: Write out your description in a Word document and copy and paste it into the description box. Spellchecking features do 

not catch errors in the alt text box. 

Considerations for GIFs and stickers in Teams: 

Teams offers built-in tools for adding GIFs (through Giphie) and stickers to liven up your messages. Neither GIFs nor stickers 

come with default alt text; a screen reader merely reads the title of the file, which is not descriptive or helpful. Stickers allow 

you to add your own alt text when you insert them into your message in the same way as above. 
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It is important to note that Teams does not allow alt text descriptions of GIF files from Giphy. To make these files accessible 

for the reader, type a brief description of the image directly in the message compose box. 

How to place an image in-line with text in Outlook: 

1. Select and right click the image. 

2. Under the “Wrap Text” drop-down menu, select “In-line with Text”. 

Fonts 

(Applies to Outlook and Teams) 

Both font style and font size are important to consider when creating an email or chat message. In Outlook, at least 11-point 

font size should be used within both the email’s body and within email signatures. The font sizes should allow for zoom or 

magnification without being distorted.  

Some fonts are easier to read than others. It is best practice to use clear and easy to read fonts. Often recommended are 

sans-serif fonts such as Arial, Calibri, and Verdana. 

In Teams, the default font is a 10-point sans-serif font. This font cannot be permanently altered. Within a message, you can 

select text and change its size to small, medium, or large. The “small” font is too small to be accessible. 

Colour Contrast 

(Applies to Outlook and Teams) 

In Outlook, email creators often change the font colour in the body and signature of their emails. Emails are often a place 

where creators can exercise creativity. Colour can highlight important information and serve as a visual indicator. However, for 

those who have low vision, colorblindness or a cognitive disability, the use of color can hinder how well they can see or 

interpret material. Colour should never be solely used to relay important information. It can be used, but you should consider 

using other indicators alongside the colour. 

Colour contrast is the difference between the value of the foreground colour (usually the font colour) and the background 

colour. If there is not sufficient colour contrast between the foreground and background, some people may not be able to 

differentiate the text from the background, or it may make deciphering the text more difficult than it needs to be. There should 

be sufficient colour contrast to make the text accessible to everyone.  

WCAG (W3C Web Content Accessibility Guidelines) 2.0 level AA requires a contrast ratio of at least 4.5:1 for normal text and 

3:1 for large text. Level AA is a good level to aim for.  

There are many resources that check for sufficient colour contrast. We recommend using WebAIM’s Colour Contrast Checker. 

This tool will tell you if the contrast is sufficient for both normal text and large text. When you enter the known colour values 

into WebAIM’s form, it will tell you if it passes or fails WCAG Level AA or AAA standards. You may also use the slider in the 

tool to find new colour codes that meet the accessibility standards (if yours do not meet them). 

In Teams, as of spring 2023, the only font colours which pass the contrast standards for accessibility are Automatic and Fun 

Blue. 

How to find colour values for Font in Outlook: 

1. Highlight the text. 

2. Go to the “Format Text” tab on the ribbon bar and select “Font Colour” in the “Font” area of the ribbon. 

3. Select “More Colours”. 

4. Go to the “Custom” tab. 

5. Under the “Color model” drop-down field, there are three fields (Red, Green, Blue) populated with numbers that make up 

the RGB formula for the colour of the text. 

6. Input these numbers into WebAIM’s contrast checker. Make sure to include the background colour if it is something other 

than white.   

7. The contrast checker will identify which colours “pass” or “fail” the visual test. 
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How to find colour values for background colours in Outlook: 

1. Select the page/area for which you want the background RGB code. 

2. Navigate to the “Options” tab on the menu bar and select “Page Color”  in the “Themes” area of the ribbon. 

3. Select “More Colours”. 

4. Go to the “Custom” tab. 

5. Under the “Color model” drop-down field, there are three fields (Red, Green, Blue) populated with numbers that make up 

the RGB formula for the colour of the background. 

6. Input these numbers into WebAIM’s contrast checker.  

7. The contrast checker will identify which colours “pass” or “fail” the visual test. 

Hyperlinks (websites) 

(Applies to Outlook and Teams) 

Did you know that screen reader users can extract hyperlinks from an email and view/browse them as a list? Have you ever 

thought about what it sounds like when a screen reader reads aloud a very long website URL? 

A hyperlink should be embedded in descriptive text that will make sense out of context. If a hyperlink is embedded in non-

descriptive text, such as “click here,” it will not make sense when extracted and presented for browsing by a screen reader. 

Too much information, such as a URL containing a mixture of numbers, letters and symbols, can be confusing and tiring for 

the reader. 

For example, if you are including a link to a step by step “how to create accessible hyperlinks” YouTube video, instead of using 

the hyperlink https://www.youtube.com/watch?v=rRec4qjsrSs use descriptive text to indicate the destination of the link: how to 

create accessible hyperlinks. Both hyperlinks will take the reader to the same web page, but the more descriptive link provides 

clarity for the screen reader user.  

How to create a hyperlink from plain text in Outlook: 

1. Highlight the descriptive text that will become your hyperlink. 

2. Right click and select “Link”. 

3. Add the website/address to the “Address” bar. 

4. The descriptive text should now appear as a hyperlink. 

How to change a URL into a descriptive hyperlink in Outlook: 

1. Right click on the URL.  

2. Choose “Edit Hyperlink” from the dropdown menu. 

3. In the “Text to display” box, enter the label/descriptor of the hyperlink.   

4. The hyperlink should now display the updated descriptive version of your URL. 

How to create a hyperlink from plain text in Teams: 

1. Select the descriptive text you wish to become a hyperlink. 

2. Select “Format” in the toolbar below the compose box. 

3. Select “Insert link” on the Message Formatting toolbar (it visually appears as a link in a chain). 

4. Type the URL in the “Address” box and press enter. 

5. The descriptive text should now appear as a hyperlink. 

How to change a URL into a descriptive hyperlink in Teams: 

1. Select the URL you wish to become a descriptive hyperlink. 

2. Select “Format” in the toolbar below the compose box. 

3. Select “Insert link” on the Message Formatting toolbar (it visually appears as a link in a chain). 

4. Type the descriptive text in the “Text to display” box and press enter. 

5. The URL should now appear as a descriptive hyperlink. 

Heading Styles 
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(Applies to Outlook and Teams) 

Using proper heading styles in long and structured emails and messages is one of the most important things you can do to 

create a navigable email and message. Headings create structure beyond visual cues and are readable by screen readers and 

other assistive technologies. Screen reader users can use shortcut keys to jump quickly between headings in an email or 

message to locate the information they need.  You can create headings by applying Outlook’s and Teams’  built-in heading 

styles.  

Use heading levels in cascading order (heading 1, then 2, then 3, and so on as your email or message’s structure requires). 

Make sure not to jump heading levels (for example going from heading 1 to heading 3 with no heading 2 in between).  

How to apply heading styles in Outlook: 

1. Select the text you wish to become a heading. 

2. Go to the “Format Text” menu on the menu bar. 

3. Select the “Styles…” button in the Styles area of the ribbon. 

4. Select the appropriate heading level style (starting with heading level 1 for top-level content). 

5. If the heading style you want is not displaying, select “Options” and use the drop-down menu to find the styles you want to 

display. “All styles” is usually a safe bet. 

6. The text should update and become a heading. 

7. You can use the “Style Inspector” to confirm that the text in your email is styled how you like. You can find the Style 

Inspector from the “Styles…” button in the “Format Text” menu. 

Tip: Heading styles can be customized as desired. To modify a heading style: 

1. Open the drop down menu for the heading in the Styles pane. 

2. Select “Modify…”. 

3. Modify the style to your heart’s content. You can change the font, size, colour, spacing, etc. 

4. Once you change the style, all the other text with that assigned style will automatically update to match. 

Pro Tip: To match a heading to an existing style (for example a bolded, 14-point, underlined block of text that already exists in 

your email): 

1. highlight the block of text. 

2. right click the heading in the Styles pane. 

3. select “update to match heading selection”. If other headings are being used, this will update them all. It is an easy way to 

customize the headings in an existing document. 

How to apply heading styles in Teams: 

1. Select the text you wish to become a heading. 

2. Select “Format” in the toolbar below the compose box. 

3. Select “Paragraph” on the Message Formatting toolbar. 

4. Select the appropriate heading level style (starting with heading level 1 for top-level content). 

Note: You may be tempted to change the colour of your headings in Teams to make them stand out visually. Currently, as of 

Spring 2023, the only colours that pass accessibility contrast tests are “Automatic” and “Fun Blue”. 

Tables 

(Applies to Outlook) 

Tables should only be used when presenting tabular data, and, whenever possible, should not be used to format an email. All 

the related data in a table should correlate appropriately and logically (for example, columns should be labelled and each item 

in the table should have its own cell). Avoid using split or merged cells in a table. This can confuse the reading order and 

usually only makes sense visually.  

Table header rows need to be marked as header rows for assistive technology to recognize them. If marked properly, a screen 

reader will read the header row before reading the corresponding cell. This makes it easier to navigate through a table without 

getting lost.    
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Tables also require alt text. Alt text for a table should include a very brief description of the table.  

An image of a table should never be used instead of a table. Use the built-in Microsoft table feature to create a table. 

Note: While Teams offers the ability to add basic tables to chat messages, this feature is not yet accessible for screen reader 

users and should be avoided whenever possible. 

How to repeat the header row in Outlook:  

1. Highlight the content in the top row of the table (the header row) and right click. 

2. Select “Table Properties" from the drop down menu.  

3. Select the “Row” tab and check “Repeat as header row at the top of each page”. 

How to apply alternative text to a table in Outlook:  

1. Select and right-click the table 

2. Select “Table Properties”  

3. Select the “Alt Text” tab  

4. Add a title and the alt text description to the appropriate boxes. The alt text will be automatically saved.  

Tip: To check the reading order of a table, tab through the table to make sure that data is in the proper order. This will be the 

same order that a screen reader will read the table.  

Spacing and Paragraph formatting 

(Applies to Outlook) 

Spacing means the space around text (margins, line spacing, word spacing, text alignment, indents, etc.). Sometimes email 

creators use “carriage returns” (i.e. pressing Enter) or the space bar to obtain a specific visual effect in an email, like adding 

white space between elements, or indenting a paragraph. However, if you press the Enter key two or more times, a screen 

reader may interpret the “Enter” as a new paragraph with no text. The screen reader may also communicate the word “blank” 

for every empty line. 

To be formatted accessibly, use the Paragraph feature in Outlook to add space between lines or paragraphs. The spacing may 

be standard throughout the document, or you can create specific spacing for certain sections.  

If possible, left-align body text and do not justify paragraphs. Justifying paragraphs adds additional spaces between letters and 

can be more difficult to read for some people. 

How to format spacing and paragraphs in Outlook: 

1. Highlight the text or paragraph to be formatted. 

2. Right click and select “Paragraph” or navigate to the “Format Text” tab on the menu bar and choose “Paragraph” in the 

“Paragraph” area of the ribbon. 

3. Format the paragraph or text as desired. There are many options for formatting. You can add spacing above or below the 

paragraph(s), indent lines or paragraphs, set your line spacing to double or single lines, create page breaks, etc.  

4. Look at the “Preview” box to verify the formatting is correct. 

Tip: You can format the spacing in your “Headings” or in the “Normal” text in the Styles pane if you want to create a standard 

spacing for your document. For example, the Heading 1 in this document is set to have a 12-point space before and a 0-point 

space after. This ensures that the headings always have a break from the sections before and are connected to the text below 

(because that is how I like it to look). 

Language 

(Applies to Outlook) 

Did you know that screen readers read text in different languages?  Did you know that when you are creating a document, 

there is a language assigned to every word in that document? Whenever there is text in another language, you should identify 
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the language of the text appropriately. This ensures that assistive technologies can render the content accurately and read the 

content according to the pronunciation rules for that language. It can be very distracting and confusing to have a screen reader 

read aloud information in English that is meant to be in a language that is not English.  

Note: you do not need to change the language for words that are incorporated into English (for example, rendezvous). 

How to change the language in Outlook: 

1. Highlight the text or section that is in a language other than English. 

2. Select the “Review” tab on the menu bar and navigate to “Language” under the “Language” area of the ribbon. 

3. Choose “Set Proofing Language”. 

4. Select the appropriate language. 

Copying messages from Word 

(Applies to Outlook) 

If you create an email in Word (including all accessibility features like headings, alt text, etc.), and then paste it into an Outlook 

message for sending, ensure you select “Use destination styles” when pasting. This setting will ensure that headings, alt text, 

and other accessibility features you implemented are copied across. Always run the Accessibility Checker before sending to 

ensure the final product is accessible. 

The Accessibility Checker 

(Applies to Outlook) 

Microsoft Office has a built-in Accessibility Checker that finds accessibility issues and warnings, explains the reasons for them, 

and offers solutions.  

Please note that the Accessibility Checker is an automated tool and will not catch every accessibility issue that may exist in 

your email. It is best used in conjunction with awareness about accessibility features as well as a manual check.  

Issues that should be manually inspected include:  

• Alternative text quality   

• Complex image descriptions 

• Captions 

• Use of headings 

• Formatted lists 

• Descriptive links 

How to Access the Accessibility Checker in Outlook: 

1. Go to the “Review” tab on the ribbon bar and select “Check Accessibility” under the “Accessibility” area of the ribbon. 

2. The Accessibility panel will open and will display any accessibility errors it has detected along with explanations and ways 

to fix them. 

How to keep the Accessibility Checker running while you work in Outlook: 

1. Navigate to the “File” tab on the menu bar and select “Options”. 

2. Select the “Accessibility” tab. 

3. Check the “Show me accessibility warnings while I work” checkbox. 

4. Select the “OK” button. 

Final Thoughts 

An accessible email or Teams message is actually a well-structured email or message and will benefit everyone. 
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We all have the power to make the world a bit more accessible. Let’s use that power and build more accessible resources for 

Albertans and other GoA employees.  

Please share information and resources with colleagues, even those you think are the “experts.” We are all learning together 

and there is so much we can learn from one another. 

Resources 

Here are some great additional resources for creating accessible Outlook emails and Teams messages.  

Accessibility for Outlook 

• Microsoft Support: Make Your Outlook Email Accessible 

• Microsoft Support: Accessibility Checker 

• Microsoft Support: Rules for the Accessibility Checker 

• Seven Steps to Creating an Accessible Email in Outlook 

Accessibility for Teams 

• Microsoft Support: Make Your Microsoft Teams Meetings, Calls, and Messages Accessible to People with Disabilities 

• Microsoft Support: Accessibility Tools for Microsoft Teams 

Creating Image Descriptions for Alt text 

• Describing Images in Publications is a DAISY webinar that introduces Image Descriptions 

• The Art and Science of Describing Images Part Two is a DAISY webinar that goes into describing Maps, Graphs, and 

Charts 

• W3C's Tutorial on Images focuses more on websites, but has useful tips for describing symbols and images in sequence. 

• AccessiblePublishing.ca Guide to Image Description provides general guidelines for publishers. This page was created by 

our accessibility testing team. 

• Poet Training Tool provides an interactive tutorial on how to describe all types of images and is great to practice your writing 

skills! 

• Long description techniques: DAISY Knowledge Base 

• WCAG Techniques for Long description: G73 – G74 – G92 

• The Art and Science of Describing Images Part Two: DAISY webinar that goes into describing Maps, Graphs, and Charts 

Other Useful Links 

• WCAG Language Guidelines: Accessibility guidelines for when to apply Languages 

• NNELS Services: Includes information on paid workshops on Alt-text and more! 

• WebAIM: Colour contrast checker that checks for sufficient contrast between the text and the background. Tip: If your 

contrast fails, use the slider bar to find a colour that is close to the original that you can use.  

• WCAG Contrast Checker: Colour contrast checker. You can import pictures to check for compliance. The checker also has 

a colour blindness simulator.  

  

https://support.microsoft.com/en-us/office/make-your-outlook-email-accessible-to-people-with-disabilities-71ce71f4-7b15-4b7a-a2e3-cf91721bbacb
https://support.microsoft.com/en-us/office/make-your-content-accessible-to-everyone-with-the-accessibility-checker-38059c2d-45ef-4830-9797-618f0e96f3ab
https://support.microsoft.com/en-us/office/rules-for-the-accessibility-checker-651e08f2-0fc3-4e10-aaca-74b4a67101c1
https://www.framingham.edu/Assets/uploads/about-fsu/accessibility/_documents/7-steps-accessible-outlook.pdf
https://support.microsoft.com/en-us/office/make-your-microsoft-teams-meetings-calls-and-messages-accessible-to-people-with-disabilities-4cdfa998-df97-48f4-8bfc-04b8131870ed#PickTab=Windows
https://support.microsoft.com/en-us/office/accessibility-tools-for-microsoft-teams-2d4009e7-1300-4766-87e8-7a217496c3d5
https://daisy.org/news-events/articles/describing-images-in-publications-w/
https://daisy.org/news-events/articles/art-science-describing-images-part-2-w/
https://www.w3.org/WAI/tutorials/images/
https://www.accessiblepublishing.ca/a-guide-to-image-description/
http://diagramcenter.org/making-images-accessible.html
http://kb.daisy.org/publishing/docs/html/images.html
https://www.w3.org/WAI/WCAG21/Techniques/general/G73
https://www.w3.org/WAI/WCAG21/Techniques/general/G74
https://www.w3.org/WAI/WCAG21/Techniques/general/G92
https://daisy.org/news-events/articles/art-science-describing-images-part-2-w/
https://www.w3.org/WAI/WCAG21/Understanding/language-of-parts.html
https://nnels.ca/services-publishers
https://webaim.org/resources/contrastchecker/
https://contrastchecker.com/
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Checklists 

Accessible Outlook Checklist 

If it is helpful, please use the following checklist to review your emails for accessibility. 

Accessible Email Features Y/N 

HTML Format: The email is formatted using the HTML style option. 
 

Headings: Headings are used in cascading order. 
 

Font: Font is Sans Serif and is at least 11 point in body text and signature. 
 

Tables: Cells in tables are not merged or split.  
 

Tables: The Header Row is repeated at the top of the table (header row 

checkbox is ticked). 

 

Tables: Tables are not being used for formatting purposes. 
 

Images: Images are in line with text. 
 

Images: Alternative text has been added to all images and graphics (including 

graphics in the signature). 

 

Complex Images: Long descriptions have been added to complex images. 
 

Formatting: Body text is not justified and is aligned left. 
 

Spacing: There is sufficient space between lines. The words in the document do 

not look crowded.  

 

Spacing: Paragraph spacing is formatted using the Paragraph feature and not 

blank spaces. 

 

Hyperlinks: Hyperlinks are embedded in descriptive/meaningful text. 
 

Colour Contrast: Any colour (other than any black and white combination) has 

been checked for sufficient colour contrast.  

 

Language: Words in different languages are tagged appropriately. 
 

Copied text from Word: Formatted text from Word has been pasted using the 

"use destination styles" option. 
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Accessible Email Features Y/N 

Accessibility Checker: The email has been checked by the Word Accessibility 

Checker and issues have been addressed.  

 

Accessible Teams Checklist 

If it is helpful, please use the following checklist to review your Teams messages for accessibility. 

Accessible Chat Features Y/N 

Headings: Headings are used in cascading order. 
 

Font: Font is “medium” or “large”. 
 

Font: Font is either “Automatic” or “Fun Blue”. 
 

Tables: Tables are avoided whenever possible.  
 

Images: Alternative text has been added to all images and graphics. 
 

Stickers: Alt text has been added to all stickers. 
 

GIFs: Textual descriptions of GIFs have been included within the body of the 

message. 

 

Complex Images: Long descriptions have been added to complex images. 
 

Hyperlinks: Hyperlinks are embedded in descriptive/meaningful text. 
 

Colour Contrast: Any colour (other than any black and white combination) has 

been checked for sufficient colour contrast.  

 

 


